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Color Picking Tips 

In this lesson, we’re going to learn a series of useful tips relating to choosing colors. 

Eyedropper Tips: Quickly Set Foreground Color (Timestamp 1:26)

The Eyedropper Tool is one of the main tools for selecting 
colors and it can be found in the Toolbar on the left side 
of the interface. The foreground and background color 
swatches can be found at the bottom of this Toolbar. You 
could activate the Eyedropper Tool and then click within 
the image to set the foreground color, but there are much 
more efficient ways of doing this. 

Set foreground color while using the Brush Tool Let’s say that you want to paint 
with a particular color that appears within your image. You would use the Brush 
Tool to do this. With the Brush Tool active, you can hold down the Option Key (Alt 
on Win) to temporarily access the Eyedropper Tool. As long as that key is held 

down, the brush tip will be converted 
into the Eyedropper. Use it to click on 
a color in the image and you will see 
that the foreground color changes to 
that color you targeted. You can then 
release the Option key and the Brush 
Tool will reappear again. When you 
start to paint, you will be painting with 
that color you selected. 

The Eyedropper Tool can 
be used to sample a color 
from within the image. 

With the Brush Tool active, we 
held down the Option key (Alt 
on Win) to temporarily access 
the Eyedropper. We are using it 
to click on a color. That color will 
be set as the foreground color. 
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Set Foreground Color with Color Picker You can also set the foreground color by 
clicking on its swatch in the Toolbar. The Color Picker will appear. With the Color 
Picker active, you can hover your mouse over the image and  the cursor will change 
into the Eyedropper. Click within the image to set the color within the Color Picker. 
This will set the foreground color. The Options Bar (above the image window) will 
display the same settings that you would get when using the Eyedropper Tool. For 
example, you can use the Sample Size menu to determine how large of an area the 
tool tip should sample from when you click within the image. 

ABOVE: We clicked on the 
foreground color swatch to open 
the Color Picker. Here, the cursor 
turns into the Eyedropper and 
we can click within the image to 
sample a color.  
LEFT: With any Eyedropper  
active, some sample settings will 
appear in the Options Bar.
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Create Keyboard Shortcut for Foreground Color Picker (3:41)

Because you can access the Eyedropper from within the Brush Tool or by clicking 
on the foreground color swatch, I never actually use the Eyedropper Tool that’s lo-
cated in the Toolbar. Because of this, I like to change the keyboard shortcut that is 
assigned to that tool. Usually, you can tap the I key to quickly access the Eyedrop-
per Tool. I would prefer that this keyboard shortcut open the Color Picker instead. 
There is a way that you can reassign shortcuts to better serve your needs. 

Click on the Edit menu at the top of the screen and choose “Keyboard Shortcuts.”  
The Keyboard Shortcuts and Menus dialog will appear. At the top, use the “Short-
cuts For” menu to choose “Tools.” This will change the list of shortcuts to show you 
only those used for Photoshop’s tools. Scroll down to find the Eyedropper Tool. 
You will see the “I” shortcut appears next to the Eyedropper as well as the other 
tools that are grouped with the Eyedropper. Delete the I from all of these tools so 
that the key is no longer assigned to these tools. 

LEFT: The “Shortcuts For” menu is being set to Tools. RIGHT: The “I” shortcut is being  
removed from the Eyedropper Tool and all the other tools that are grouped with the  
Eyedropper Tool.
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Then, scroll down to find the “Foreground Color Picker” option. Click on it and type 
the letter I into the field to the right of the text. This will assign the I key to now 
open the Foreground Color Picker. Click the OK button to exit the dialog. 

Use Eyedropper to Sample from Anywhere on Your Screen (6:14)

When using the Eyedropper, you are not limited to sampling a color from within 
your image. You can actually sample a color from anywhere on your screen. This 
can even include a web browser that’s running behind the Photoshop window. To 
do this, use the Eyedropper to first click within your image, but keep the mouse 
button held down. With the button held down, drag the Eyedropper anywhere on 
your screen. When you release the mouse button, Photoshop will sample the color 
that was under the cursor, regardless of what the tool is pointing to on your screen. 

The keyboard shortcut “I” is being assigned to the Foreground Color Picker. 
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Choosing the Sample Size (7:18)

When using the Eyedropper, the Sample Size menu will appear in the Options Bar 
above the image window. This allows you to determine how large of an area the 
tool can sample from to select a color. For example, the “5 by 5 Average” option 
will take an area that is five pixels wide by five pixels tall and take the average color 
from that area. 

It can sometime be difficult to 
know exactly how large of an 
area that will be on your pic-
ture, so there is another way of 
specifying a sample size. Make 
a selection of the area you 
would like to average. Then click on the Filter menu and choose Blur > Average. 
This command will blur the selected area so much that it turns into a single, solid 
color. Use the Eyedropper to sample that color. This will set the color as the fore-
ground color. Use the Undo command to remove the blurring. 

When the Eyedropper Doesn’t Work the Way you Want (8:35)

Sometimes, Photoshop can get in the way of the Eyedropper working the way you 
want. For example, let’s say you use the Eyedropper to sample a particular color, 
but Photoshop instead selects solid white or solid black. This can happen when 
working with layers that have masks, like adjustment layers. If the mask is active, 
Photoshop can only see the contents of the mask, so that’s what it’s going to sam-
ple from. To prevent this, make sure that the layer is active, and not the mask. You 
can tell which is active because little white brackets will appear around its thumb-
nail in the Layers Panel. If the mask is active, click on the layer thumbnail to make it 
active instead. Now, Photoshop will be able to see the colors in the image. 

LEFT: A selection was made around the area we want to 
sample a color from. RIGHT: The Average Blur filter was 
used to create a single color from the selected area.

At far left, the  
mask is selected.  
Directly left, the 
layer is selected. 
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I wish that some of the adjustment layers were smart enough to pay attention to 
the foreground color. For example, when you create a Photo Filter adjustment lay-
er, you can choose what color filter to use. The Photo Filter settings have a default 
filter in place, but I wish that it automatically used the foreground color. In cases 
like this, double-click on the color swatch to access the Color Picker. Then, open 
the Swatches Panel on your screen. If it is not already visible, you can access it by 
clicking on the Window menu and choosing Swatches. At the top of the Swatches 
Panel, there is a bar of color swatches, which represent the last several colors you 
used. The swatch on the far left represents the current foreground color. Use the 
Color Picker Eyedropper to click on this swatch and then click OK. The adjustment 
layer will now be set to use that foreground color. 

The Color Picker is open and we want to choose the foreground color. We opened the 
Swatches Panel and the foreground color is shown in the top left (Circled). We are using the 
Color Picker Eyedropper to click on it. 
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Copy a color (13:31)

You can copy a color to either use in another document, email to someone, or de-
scribe to someone in such a way that they can create the same exact color. The 
Color Picker contains sets of numbers that you can copy to share with others or to 
use in another document. 

In the Color Picker, you can see the RGB values for the active color. These are the 
numbers that precisely describe the color you’re currently working with. If you 
gave these numbers to someone else, they could recreate the same color AS LONG 
AS they are working in the same color space. Examples of color spaces include 
sRGB, AdobeRGB or ProPhoto.

The Color Picker also shows the Hexadecimal number (#) for the chosen color. This 
number represents a combination of the red, green and blue values and it can also 
be used to copy a color from one document to another. 

If you want to share a color with someone and you’re not sure what color space 
they’re using, you can give them the LAB values, which are also found within the 
Color Picker dialog. These numbers are what you could call “color independent.” 
They will produce the same color regardless of what color space is being used. 

The color values inside 
the Color Picker can 
be used to precisely 
describe a color so 
that it can be used in 
another document or 
given to someone else.
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Troubleshooting the Color Picker (15:35)

Occasionally, you’ll open the Color Picker and it will not look the way you expect 
it to look. If this is the case, it means that the little dot that is usually set to the 
“H” field got moved to another one of the color value fields (see screen shot). The 
dot placement determines what appears in the vertical color bar. The large color 
square shows what the two unchosen options are. The “H” value stands for Hue, 
which means basic color. When the dot is placed on the H, the vertical bar will show 
the Hue and the big color square will show the Saturation and Brightness. If the 
Color Picker ever looks strange, set the little dot back to the H field. 

If the Color Picker ever looks 
really “low tech,” where there 
are hardly any colors show-
ing up at all, that means the 
“Only Web Colors” check 
box got turned on. It’s locat-
ed at the bottom of the Color 
Picker. Simply turn the check 
box off to return to normal. 

If the Color Pick-
er ever looks odd, 
check to make sure 
that the dot is placed 
next to the H value. If 
it’s not, click on the 
circle next to the H 
in order to place the 
dot there.

If the Color Picker 
every displays too 
few colors, as shown 
at left, turn off the 
“Only Web Colors” 
check box. 
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Alternatives to the Color Picker (17:04)

There are two alternatives to the Color Picker that I commonly use. One of these 
is the Color Panel. If the Color Panel is not visible on your screen, you can access 
it by clicking on the Window menu and choosing Color. Use the little menu in the 
top right corner of the panel to determine how it will look. I like to choose the Color 
Wheel option, which will cause the panel to display a different type of color picker. 
You can set the hue by using the circular gradient. Then, click within the central, 
triangle shape, to choose the saturation and the brightness. 

Often times, I need to work with the oppo-
site of a particular color, and that’s where 
this color wheel can come in handy. In the 
color wheel, opposite colors are located di-
rectly across from each other. For example, 
the opposite of blue is yellow, so yellow ap-
pear on the opposite side of the color wheel 
from blue. 

There is a way to ensure that you’re getting 
EXACTLY the opposite of a color, and that is 
by using the settings at the top of the Col-
or Panel. The Hue value can range from 0 to 
360 (because there’s 360 degrees in a circle). 
If the number is greater than 180, then click 
within the field, place the cursor right after 
the number and type -180. This will do the 
math and subtract 180 from the current hue 
value. This will result in the color’s opposite. If 
the hue value is less than 180, then click right 
after the number and type +180. This will add 
180, giving you the exact opposite hue. 

The Color Panel is set to display the 
Color Wheel. You can determine the 
exact opposite of a color by adding or 
subtracting 180 (circled) from the hue 
value.
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Using Math in the Color Panel (19:37)

There are other ways we can use math to get certain colors in the Color Panel. Let’s 
say that we want to take the rainbow of colors in the Hue slider and divide them 
into five, equally-spaced colors. We’ll start by setting the Hue value to 360 and 
then creating a new color swatch. We can do this by clicking on the little plus icon 
in the bottom right corner of the Color Panel. A dialog will appear where we can 
name the color swatch and then click OK. In the video example, we just named the 
swatch “1.” 

Now we’ll use the number field to the right of the Hue slider to set the first color. 
After the number 360, we’ll type /5. This will divide 360 by five (360/5) and place 
the Hue slider on the coordinating color. This resulting number was 72, so we know 
that the five numbers need to be evenly spaced by 72. We’ll click the New Color 
Swatch icon again and this time name the swatch “2.” Then, we’ll take the number 
in the Hue field and type +72 after it. This will give us our third color. We’ll continue 
this process until we have all five swatches, spaced equally apart. We can open the 
Swatches Panel and see that our new swatches have been added. 

FAR LEFT: We are 
creating five color 
swatches by using 
math to ensure the 
colors are evenly 
spaced apart.  
DIRECTLY LEFT: The 
five swatches appear 
within the Swatches 
Panel. 
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Access the Color Picker on Demand (23:08)

There is a way to access the Color Picker 
only when you need it. This can prevent it 
from taking up unnecessary space in the in-
terface. On a Mac, hold down the Control, 
Option & Command keys and then click 
within the image. On Windows, hold down 
the Shift and Alt keys, and click the right 
mouse button.

The Color Picker will appear and it will dis-
play the vertical hue strip and the color 
square that determines the saturation and 
brightness. Note that you do not need to keep those three shortcut keys held down 
after you click. Just keep the mouse button held down and the Color Picker will 
remain on the screen. As you move between the hue bar and gradient square, the 
targeted color will change because it thinks you are repositioning the sample circle. 
If you would like the sample circle to remain in place while you switch between the 
bar and the square, then hold down the Space Bar. 

By default, the Color picker shows up as the square 
with the vertical hue bar next to it. There is a way 
we can specify that it show up as a circle, and that is 
by changing the Preferences. Click on the Photoshop 
menu and choose Preferences > General. (On Win-
dows, the Preferences can be found under the Edit 
menu.) The Preferences dialog will appear. At the top, 
there is a setting for HUD Color Picker. This stands for 
“Heads Up Display.” This menu can be used to choose 
the wheel instead of the Hue Strip. You can also de-
termine its size within this menu. 

Keyboard shortcuts can be used to tem-
porarily access this version of the Color 
Picker, only when you need it.

The HUD Color Picker menu 
can be used to switch to the 
circular Color Picker.
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Selecting the Background Color (27:36)

Up until now, we have been talking about how to set the foreground color. Now 
let’s look at how we can quickly set the background color. You COULD click on the 
background color swatch at the bottom of the Toolbar. This would call up the Color 
Picker and allow you to set the background color. However, I love using keyboard 
shortcuts. 

At the bottom of the Toolbar, you will see that there is a little right-angle 
arrow between the foreground and background swatches. Click this lit-
tle arrow to swap the colors. Alternatively, you can tap the X key (think 
eXchange) to swap the two colors. We can use this in conjunction with 
the keyboard shortcut for accessing the Foreground Color Picker. 

Let’s say we want to quickly set the background color. We’ll tap the X key to swap 
the foreground and background colors. What used to be the background color is 
now the foreground color. Then, we’ll use the keyboard shortcut we created (The 
I key) to open the Foreground Color Picker. We’ll use the Color Picker to choose 
the color we’d like to use as the background color and then click OK. Finally, we’ll 
tap the X key again to swap the colors so that color we just chose becomes the 
background color.

If a Setting Accidentally Affects the Background Color (29:25)

There may be times that some color settings are 
affecting the background color instead of the 
foreground color. If that’s the case, look at the 
two little overlapping swatches that represent 
the foreground/background colors. This likely got 
switched to work on the background color. You 
can tell which swatch is active because it will have 
a gray outline around it. Simply click on the fore-
ground swatch if you want the settings to affect 
the foreground color.

The overlapping swatches allow 
you to switch between working 
on the background and  
foreground colors.
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The Eyedropper Color Ring (30:21)

Whenever you click on the image using the 
Eyedropper, a color ring will appear where 
you click. The upper, inner half of the ring 
will show you the color you’re currently 
targeting. The bottom half is showing the 
color you had before. The outer portion of 
the ring is showing a shade of gray. This 
allows you to compare the color you’re 
targeting with a neutral color. Sometimes, 
the eye perceives something as gray when 
it’s truly not. This outer ring will allow for 
a true comparison so you can tell just how 
colorful an area is. 

If you don’t like this ring to appear when 
you use the Eyedropper, there is a way 
to turn it off. When using an Eyedropper, 
some settings will appear in the Options 
Bar. One of these is an icon that looks like 
the ring. Click this icon to turn the ring fea-
ture off. 

The color ring appears when you sample a 
color using the Eyedropper. 

Use this icon (in the Options Bar) to turn 
off the color ring, if desired.


